
 

销售邮箱：sales@tronlong.com                       技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                        公司官网：www.tronlong.com 

DSP+ARM+FPGA 

三核主板方案领导

者 
TMS320C6748 开发板使用手册 

 

Revision History 

 

Revision 

No. 

Description Draft  

Date 

Remark 

V1.0 1.初始版本 2014/5/5  

    

    

    

    

 

 

  



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  2/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
 

 

 

 

 

 

 

 

 

 



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  3/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
阅前须知 

版权声明 

  广州创龙电子科技有限公司保留随时对其产品进行修改和完善的权利，同时也

保留在不作任何通告的情况下，终止其任何一款产品的供应和服务的权利。请用户

在购买前向我司获取相关产品的最新信息，本文档一切解释权归广州创龙所有。 

 ©2014-2018 Guangzhou Tronlong Electronic Technology Co.,Ltd. All rights reserved. 

公司简介 

  广州创龙电子科技有限公司（简称“广州创龙”，英文简称"Tronlong"），是杰

出的嵌入式方案商，专业提供嵌入式开发平台工具及嵌入式软硬件定制设计及技术

支持等服务，专注于 DSP+ARM+FPGA 三核系统方案开发，和国内诸多著名企业、

研究所和高校有密切的技术合作，如富士康、威胜集团、中国科学院、清华大学等

国内龙头企业和院校。 

  TI 嵌入式处理业务拓展经理 ZhengXiaolong 指出：“Tronlong 是国内研究

OMAP-L138 最深入的企业之一，Tronlong 推出 OMAP-L138+Spartan-6 三核数据采

集处理显示解决方案，我们深感振奋，它将加速客户新产品的上市进程，带来更高

的投资回报率，使得新老客户大大受益。” 

  经过近几年的发展，创龙产品已占据相关市场主导地位，特别是在电力、通信、

工控、音视频处理等数据采集处理行业广泛应用。创龙致力于让客户的产品快速上

市、缩短开发周期、降低研发成本。选择创龙，您将得到强大的技术支持和完美的

服务体验。 

产品保修 

  广州创龙所有产品保修期为一年，保修期内由于产品质量原因引起的，经鉴定

系非人为因素造成的产品损坏问题，由广州创龙免费维修或者更换。 

更多帮助 

  销售邮箱：sales@tronlong.com 技术邮箱：support@tronlong.com 

  公司总机：020-8998-6280  公司官网：www.tronlong.com 

  DSP 论坛：www.51dsp.net 

mailto:sales@tronlong.com
mailto:support@tronlong.com
file:///E:/svn/company/OMAPL138产品资料/OMAPL138文档源材料/TL138-EVM-A3用户手册word格式/www.tronlong.com
www.51dsp.net


 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  4/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
目录 

1 开发板准备 ........................................................................................................................... 7 

1.1 测试开发板硬件 ........................................................................................................ 7 

1.2 查看仿真器驱动是否正常安装 ................................................................................ 7 

2 基于仿真器的程序加载和烧写 ........................................................................................... 8 

2.1 设置工程配置文件信息 ............................................................................................ 8 

2.2 测试仿真器是否正常连接 ...................................................................................... 10 

2.3 加载 GEL 文件 ......................................................................................................... 11 

2.4 CCS 连接开发板 CPU ............................................................................................. 12 

2.5 运行 GEL 文件来初始化开发板 ............................................................................. 13 

2.6 查看 CPU 版本号..................................................................................................... 14 

2.7 加载文件烧写程序 .................................................................................................. 14 

2.8 基于仿真器烧写程序到 NAND FLASH ................................................................ 15 

2.9 NAND FLASH 烧写格式镜像转换方法 ................................................................ 16 

3 基于串口的程序加载和烧写 ............................................................................................. 18 

3.1 串口加载和烧写格式镜像转换方法 ...................................................................... 18 

3.2 程序加载和运行 ...................................................................................................... 20 

3.3 基于串口烧写程序到 NAND FLASH .................................................................... 24 

4 基于 SD 卡运行程序 .......................................................................................................... 27 

4.1 SD 启动格式镜像转换方法 .................................................................................... 27 

4.2 将程序烧写到 SD 卡 ............................................................................................... 29 

4.3 SD 卡模式启动开发板 ............................................................................................ 32 

5 CCS 工程新建和编译 ........................................................................................................ 32 

5.1 新建工程 .................................................................................................................. 34 

5.2 编写程序 .................................................................................................................. 37 

5.3 编译和运行程序 ...................................................................................................... 38 

6 CCS 工程导入和编译步骤 ................................................................................................ 40 



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  5/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
7 Demo 例程演示 .................................................................................................................. 45 

7.1 GPIO_LED——GPIO 输出（LED 灯） ................................................................ 47 

7.2 GPIO_KEY——GPIO 输入（按键中断） ............................................................ 47 

7.3 TIMER——定时器 .................................................................................................. 48 

7.4 UART0_INT——UART0 串口中断收发 ............................................................... 48 

7.5 UART1_POLL——UART1 串口查询收发............................................................ 49 

7.6 UART2_INT——UART2 串口中断收发 ............................................................... 50 

7.7 RS485——RS485 串口查询收发............................................................................ 51 

7.8 IIC_EEPROM——IIC EEPROM 读写 ................................................................... 52 

7.9 SPI_FLASH——SPI FLASH 读写 ......................................................................... 53 

7.10 WatchDog——看门狗.......................................................................................... 54 

7.11 NMI——不可屏蔽中断 ....................................................................................... 55 

7.12 PWM——高精度脉冲宽度调制器 PWM 输出 .................................................. 56 

7.13 ECAP_APWM——增强型捕获模块 ECAP 辅助输出 ...................................... 57 

7.14 PWM_ECAP——增强型捕获模块 ECAP 捕获 ................................................. 59 

7.15 RTC——RTC 时钟 .............................................................................................. 61 

7.16 LCD——LCD 显示 .............................................................................................. 62 

7.17 TOUCH——触摸屏 ............................................................................................. 64 

7.18 MMCSD——SD 卡读写 ...................................................................................... 65 

7.19 USB_DEV_BULK——USB OTG 从方式（USB BULK 管道通信） ............. 66 

7.20 USB_DEV_MSC——USB OTG 从方式（虚拟存储设备） ............................ 75 

7.21 USB_DEV_SERIAL——USB OTG 从方式（USB 虚拟串口） ...................... 79 

7.22 USB_HOST_KEYBOARD——USB OTG 主方式（USB 键盘） .................... 82 

7.23 USB_HOST_MOUSE——USB OTG 主方式（USB 鼠标） ............................ 83 

7.24 USB_HOST_MSC——USB OTG 主方式（U 盘内容查看） .......................... 83 

7.25 ENET_HTTPD——网络 Web 服务器 ................................................................ 85 

7.26 ENET_ECHO——网络 Socket 通信 ................................................................... 87 

7.27 AUDIO_LINE_OUT——Line Out 音频输出 ..................................................... 94 



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  6/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
7.28 AUDIO_MIC_IN——Mic In 音频输入 .............................................................. 95 

7.29 AUDIO_LINE_IN——Line In 音频输入 ............................................................ 95 

7.30 McBSP——McBSP 总线数据收发 ..................................................................... 96 

7.31 VPIF_OV2640——VPIF 总线 CMOS 摄像头数据采集 ................................... 98 

7.32 EMIF_AD7606——EMIF 总线 8 通道并口 AD 数据采集 ............................... 99 

7.33 EDMA3——EDMA3 一维数据传输 ................................................................ 103 

7.34 EDMA3_TRANSPOSE——EDMA3 二维数据传输 ....................................... 104 

7.35 uPP——uPP 数据收发 ....................................................................................... 105 

7.36 SATA——SATA 读写 ....................................................................................... 105 

7.37 FFT——快速傅里叶变换/逆变换（不开缓存） ............................................. 105 

7.38 FFT_Benchmark——快速傅里叶变换/逆变换（打开/关闭缓存速度对比） 109 

7.39 FIR——有限长单位冲激响应滤波器 ............................................................... 119 

7.40 IIR——无限脉冲响应数字滤波器.................................................................... 129 

7.41 Matrix——矩阵运算 .......................................................................................... 134 

7.42 DCT——图像离散余弦变换 ............................................................................. 136 

8 更多帮助 ........................................................................................................................... 139 

9 附录 Boot Mode Selection ................................................................................................ 140 

  

   

 

 

 

 

 

 

 



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  7/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
1  开发板准备  

1.1 测试开发板硬件 

 将开发板的拨码开关 1~5 号对应拨到 00101（说明见附录，1 代表 ON，0 代表 OFF，

X 代表任意，即可以是 0 也可以是 1），这是 UART2 档位。RS232 串口线通过 USB

转串口接到 PC 机的 USB 口，DB9 母头（带孔）接底板 UART2 口，设置 PC 机调试终

端 COM 口，波特率为 115200，8N1，无检验位。推荐使用 ZOC 串口调试终端软件，

TMS320C6748 产品资料光盘的 tools 目录下有 ZOC 的安装包 zoc602.zip。   

 假如是使用 ZOC 的用户，依次点击菜 ZOC 单栏的 Options->Jump to->Devices，然

后选择 Serial/Modem。在 Serial/Modem 中扫描然后选择 COM 口，波特率为 115200，

8N1，无检验位，RTS signal off，DTR signal off，其它选项按默认设置。 

 开发板上电，即可在调试终端看到系统自动打印的 BOOTME 信息，说明开发板硬

件正常工作了。 

 

 

图 1 

 

1.2 查看仿真器驱动是否正常安装 

开发板断电，连接好仿真器和开发板，并将仿真器的 USB 口插进电脑 USB 插槽，

开发板上电。右击计算机图标，点击“设备->通用串行总线控制器”，查看是否有对应

的仿真器的选项出现，如有说明仿真器驱动已经正常安装，否则请先正确安装 CCS。 
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图 2 

 

2  基于仿真器的程序加载和烧写 

2.1 设置工程配置文件信息 

 打开 CCS，点击菜单"View->Target Configrations"，右边弹出如下对话框： 
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图 3 

 

 点击左边第一项，新建配置文件。 

 

 

图 4 

 

 输入工程配置文件名字，点击 Finish。 
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图 5 

 

 在弹出的对话框的"Connection"下拉框中选择对应的仿真器类型，在"Board or Device"

下拉框中选择 TMS320C6748，点击右边的 Save 按钮。 

 

 

图 6 

 

2.2 测试仿真器是否正常连接 
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点击"Test Connection"，看是否提示成功连接，如下图。如提示错误，请检查开发板

是否上电、接线是否正常。 

 

 

图 7 

 

2.3 加载 GEL 文件 

 点击 CCS 菜单"Run->Debug"，弹出以下界面。可以看到 C674X_0。  

 

 

图 8 

 

 右击 C674X_0 核，在弹出的界面中选择"Open GEL Files View"选项，右下角会弹出

"GEL Files(TMS320C674X)"对话框。 
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图 9 

 

 在对话框内点击右键，在弹出的界面中选择"Load GEL"。选择 C6748 光盘 images 下

的 GEL 文件 Tronlong_C6748.gel，再点击确定，接着右下角的"GEL Files(TMS320C674X)"

对话框会出现"Success"提示语句，如下图： 

 

 

图 10 

 

2.4 CCS 连接开发板 CPU 

 右击 C674X_0 核，选择"Connect Target"选项，会显示 Suspended 状态。这说明 CCS

已经和开发板 CPU 正常连接起来了。 
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图 11 

 

备注：此处提示的"No source****"内容不是错误信息，无需关心。 

2.5 运行 GEL 文件来初始化开发板 

点击菜单"Scripts->TronLong_DSP_C6748->TronLong_C6748_456MHz"，运行后会提

示"Config Complete"，开发板初始化完成。 

 GEL 文件的作用是在调试模式初始化硬件环境（DDR2、NAND FLASH 等），只有

加载了 GEL 文件后才会出现此菜单，只要开发板不断电初始化操作只需要执行一次就

可以。 

 

 

图 12 
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图 13 

 

2.6 查看 CPU 版本号 

点击菜单"View->Memory Browser"，会出现"Memory Browser"窗口，在输入框中输入

"0x11700000"并回车，选择"Character"可查询 TMS320C6748 核的版本号，CPU 版本号在

out 镜像文件格式转换时将会用到。此处查询到的 DSP 核版本号为：d800k008，如下图： 

 

 

图 14 

 

2.7 加载文件烧写程序 
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点击"Run->Load->Load Program"，选择光盘中 images 目录下的 C6478_NandWrite.out 

文件，点击 OK。接着点击绿色三角启动按键 。在 Console 窗口会有打印信息

出现，提示是否擦除 NAND FLASH。 

 

 

图 15 

 

备注：如果第一次操作没有出现 Console 窗口，请按黄色键暂停运行 ，然后按

重启键 复位 CPU，接着点击绿色三角启动按键 ，即可看到 Console 窗口

会有打印信息出现。 

2.8 基于仿真器烧写程序到 NAND FLASH 

    以 LED 流水灯程序为例，将光盘"demo\StarterWare\Binary\GPIO_LED.ais"拷贝到一

个非中文路径，在 Console 窗"[C674X_0] Do you want to global erase NAND FLASH?"行后

面输入"y"，按回车键进行擦除 NAND FLASH。擦除完后，会提示"Enter the binary AIS file 

name to flash (enter 'none' to skip) :"，在下一行空白处输入需要烧写的 DSP 程序镜像

GPIO_LED.ais 的完整路径，并按回车键。等待一会会出现"NAND boot preparation was 

successful!"即烧写成功，如下图所示：     
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图 16 

 

 烧写完 GPIO_LED.ais 镜像后，拔下开发板仿真器接口，将开发板的拨码开关 1~5 号

对应拨到 01110 档位，这是 NAND FLASH 启动档位，接着上电就可以看到开发板 LED

流水灯效果。 

2.9 NAND FLASH 烧写格式镜像转换方法 

仿真器只支持 ais 格式镜像烧写，而 CCS 编译程序生成的镜像为 out 格式文件，所以

需把 out 格式镜像转换为 ais 格式镜像才能用仿真器进行烧写，有关格式转换步骤如下： 

（1） 打开 AISgen 软件。 

 打开 AISgen 软件，弹出如下界面： 

备注：如果 AISgen 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen 

for D800K008\AISgen_d800k008.exe"。 
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图 17 

 

（2） 点击"File->Load Configuration" ，弹出如下加载界面： 

 

 

图 18 

 

（3） 选择光盘 images 目录下配置文件 C6748AISgen_456M_config.cfg，在"Device Type 

"下拉框中选择CPU对应的CPU版本号，此版本号可根据前面版本号查询操作得到。



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  18/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
在"Boot Mode"下拉框选择"NAND Flash"。在"DSP Application File "下拉框中选择 out

格式文件所在路径（在光盘"demo\StarterWare\Binary"目录下有很多现成的 out 格式程

序镜像），在"AIS Output File "填写 ais 格式文件输出路径和名字。  

最后点击"Generate AIS"按键，即可生成用于仿真器烧写的 ais 格式镜像，如下图

所示： 

 

 

图 19 

 

3  基于串口的程序加载和烧写 

3.1  串口加载和烧写格式镜像转换方法 

（1） 打开 AISgen 软件。 

 打开 AISgen 软件，弹出如下界面： 

备注：如果 AISgen 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen 

for D800K008\AISgen_d800k008.exe"。 
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图 20 

 

（2） 点击"File->Load Configuration" ，弹出如下界面： 

 

 

图 21 

 

（3） 选择光盘 images 目录下配置文件 C6748AISgen_456M_config.cfg，在"Device Type 
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"下拉框中选择CPU对应的CPU版本号，此版本号可根据前面版本号查询操作得到。

在"Boot Mode"下拉框选择对应的串口"UART2"。在"DSP Application File "下拉框中选

择 out 格式文件所在路径（在光盘"demo\StarterWare\Binary"目录下有很多现成的 out

格式程序镜像），在"AIS Output File "填写 ais 格式文件输出路径和名字。  

最后点击"Generate AIS"按键，即可生成用于串口加载和烧写的 ais 格式镜像，如

下图所示： 

 

 

图 22 

 

3.2  程序加载和运行 

(1) 开发板设置 

 将开发板的拨码开关 1~5 号对应拨到 00101（说明见附录，1 代表 ON，0 代表 OFF，

X 代表任意，即可以是 0 也可以是 1），这是 UART2 档位，然后将开发板上电。 

(2) 打开 UartHost 软件 

 打开 UartHost 软件，弹出如下界面： 
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备注：如果 AISgen 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen 

for D800K008\UartHost\UartHost.exe"。 

 

 

图 23 

 

(3) 加载和运行程序 

 选择转换好的串口 ais 格式烧写镜像，修改串口为对应端号，波特率：115200，如下

图所示。 

备注：此时调试串口软件需要关闭，因为调试串口软件会占用串口。 
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图 24 

 

 点击开始，弹出如下界面： 

 

 

图 25 

 

 将开发板复位，程序会通过串口加载到 DDR2 中，然后自动运行。UartHost 打印信

息如下： 

 

 

图 26 
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(4) 通过 slh_OMAP-L138 软件加载和运行程序。  

 也可以使用 slh_OMAP-L138 软件通过 DOS 命令行加载和运行程序。可以在光盘

"demo\StarterWare\HostApp\tools"目录下找到 slh_OMAP-L138.exe 软件，将其拷贝到 C 盘

根目录。开发板拨码开关保持在 UART2 档位，在 Windows 开始菜单底部输入 cmd 进入

控制台窗口（注意：COM 口和镜像路径参数需和实际一致，镜像路径为上面步骤产生的

ais 格式镜像文件路径），并执行加载命令，如下图所示： 

备注：此时调试串口软件需要关闭，因为调试串口软件会占用串口。 

DOS# cd C:\ 

DOS# slh_OMAP-L138 -waitForDevice -p COM13 

 C:\TMS320C6748\demo\StarterWare\Binary\GPIO_LED.ais 

 

 

图 27 
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 此时将开发板复位，程序会通过串口加载到 DDR2 中，然后自动运行。Windows 控

制台窗口打印信息如下： 

 

 

图 29 

 

3.3  基于串口烧写程序到 NAND FLASH 

(1) 开发板设置 
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 将开发板的拨码开关 1~5 号对应拨到 00101（说明见附录，1 代表 ON，0 代表 OFF，

X 代表任意，即可以是 0 也可以是 1），这是 UART2 档位，然后将开发板上电。 

(2) 程序烧写 

 在光盘"demo\StarterWare\HostApp\tools"目录下找到 sfh_OMAP-L138.exe 软件，将其

拷贝到 C 盘根目录。在 Windows 开始菜单底部输入 cmd 进入控制台窗口，并执行烧写命

令（注意：COM 口和镜像路径参数需和实际的一致，镜像路径为上面步骤产生的.bin 格

式文件路径），如下图所示： 

备注：此时调试串口软件需要关闭，因为调试串口软件会占用串口。 

DOS# cd C:\ 

DOS# sfh_OMAP-L138 -flash_noubl -targetType C6748 -flashType NAND -p COM13 

C:\TMS320C6748\demo\StarterWare\Binary\GPIO_LED.ais 

 

 

 

图 30 

 

 将开发板复位，程序会通过串口烧写到 NAND FLASH 中。Windows 控制台窗口打印

信息如下： 
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 将开发板的拨码开关 1~5 号对应拨到 01110，这是 NAND FLASH 启动档位，然后将

开发板上电，程序即会正常运行。 

 在 Windows 控制台输入如下命令可以查看 sfh_OMAP-L138.exe 软件命令的所有用法。 

DOS# sfh_OMAP-L138.exe -h 
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4  基于 SD 卡运行程序 

4.1 SD 启动格式镜像转换方法 

（1） 打开 AISgen 软件。弹出如下界面： 

备注：如果 AISgen 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen 

for D800K008\AISgen_d800k008.exe"。  
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（2） 点击"File->Load Configuration" ，弹出如下界面： 

 

 

图 34 

 

（3） 选择光盘 images 目录下配置文件 C6748AISgen_456M_config.cfg，在"Device Type 

"下拉框中选择CPU对应的CPU版本号，此版本号可根据前面版本号查询操作得到。
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在"Boot Mode"下拉框选择"MMC/SD0"。在"DSP Application File "下拉框中选择 out

格式文件所在路径（在光盘"demo\StarterWare\Binary"目录下有很多现成的 out 格式程

序镜像），在"AIS Output File "填写 ais 格式文件输出路径和名字。  

最后点击"Generate AIS"按键，即可生成可烧写到 SD 卡的 ais 格式镜像，如下图

所示： 

 

 

图 35 

 

4.2 将程序烧写到 SD 卡 

 将 SD 卡插入 PC，双击光盘"demo\Host_App\BOOTICE\BOOTICEx86.exe"，在弹出

的界面中选中插入的 SD 卡，如下图所示： 
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 点击“扇区编辑（S）”，弹出如下界面： 

 

 

图 37 

 

 点击从文件恢复扇区按钮，如下图所示： 
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 点击后弹出如下界面： 

 

 

图 39 

 

 选中上面转换好的镜像，“起始扇区号：”填 64，“恢复扇区数：”无需更改，使

用默认值即可。填好后点击“恢复（R）”，如下图所示： 

 

 

图 40 
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 烧写成功会弹出如下界面： 

 

 

图 41 

 

备注：因为 0~63 扇区为保留扇区、存储分区和文件分配表等内容，所以从 0~63 任意一

个扇区开始写入会破坏 SD 卡原有数据。 

4.3 SD 卡模式启动开发板 

 将 SD 卡插入开发板，并将开发板的拨码开关 1~5 号对应拨到 00111，这是 SD 卡启

动档位，然后将开发板上电，可以看到程序已正常运行。 

5  CCS 工程新建和编译 

 为了更好的显示中文，请修改 Preferences 中 C++编译器字体大小及控制台字体，点

击 CCS 菜单"Windows->Preferences"，如下图所示： 
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 在弹出的界面中修改 C/C++ Editor Text Font 字体 为 12 号以上，如下图所示： 

 

 

图 43 
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5.1 新建工程 

 点击 CCS5 菜单的"File->NEW->Project->Code Composer Studio->CCS Project"，弹出

如下界面： 
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 然后点击 Next，弹出对话框，并修改为如下： 
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Project name: hello，CCS 工程名字； 

Family: C6000； 

Variant: C674x Floating-point DSP->TMS320C6748； 

Connection:XDS100v2，仿真器类型； 

 在"Empty Projects"下方选择"Empty Project(with main.c)"，点击 Finish 就可以完成工程

新建了，弹出如下界面： 
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5.2 编写程序 

 编辑 main.c 文件，增加用户需要实现的功能代码，例如增加打印信息： 

 

#include<stdio.h> 

int main(void) { 

 printf("********Enjoy your TL6748-EVM!........www.tronlong.com********\n"); 

 return 0; 

} 

 编辑完成后如下图所示： 
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5.3 编译和运行程序 

 右击工程，在弹出来的对话框中点击"Build Project"，即可对当前工程编译，如下图： 

 

 

图 49 

 

 编译完毕后，可在左侧工程的 Binaries 下看到产生了可执行 hello.out 文件，如下图： 
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 在程序加载前，先按照前面章节步骤连接开发板并用 GEL 文件初始化 DSP 核，再点

击左上角的 load 键，选择要加载的 hello.out 文件。 

 

 

图 51 

 

 等待程序加载完成，然后点击 程序运行按钮，可以发现 CCS 的 Console 控制台有

程序中指定的信息打印出来，至此最简单的 DSP 裸机程序开发成功。 

 

 

图 52 
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 通过以上步骤，用户可以学习如何新建工程和在 CCS 下运行 DSP 程序了。 

6  CCS 工程导入和编译步骤 

（1） 将光盘中 demo 整个目录拷贝到一个非中文目录下。打开 CCS，点击菜单

"File->Import"，弹出以下对话框： 

 

 

图 53 

 

（2） 点击"Code Composer Studio->Existing CCS Eclipse Projects"后再点击 Next，如下

图所示： 
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（3） 在弹出的对话框的"Select search-directory"后面点击 Browse，选择光盘 demo 目录

的存放路径，选择后如下图所示： 
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（4） 点击"Select All"，，再点击 Finish 就可以导入现有所有的 CCS 工程，同时会在 CCS

的左边出现如下界面： 
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（5） 然后右击任意一个工程，在弹出来的对话框中点击"Rebuild Project"，即可对当前

工程编译，如下图： 
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（6） 编译完毕后，可在左侧工程的 Binaries 下看到产生了可执行 out 文件，如下图： 

 

 

图 58 

 

（7） 开发板上电，点击"Run->Debug"，出现 Debug 界面。 

 

 

图 59 
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 确保 C6748 核状态为"Suspended"后，点击脚本初始化 CPU，如下图所示： 

 

 

图 60 

 

（8） 再点击左上角的 load 键，选择要加载的 out 格式镜像文件，如下图所示： 

 

 

图 61 

 

 等待程序加载完成，然后点击 程序运行按钮，可以发现程序已正常运行。点击黄

色的暂停键 ，再按 F5 会进去函数里面，按 F6 就单步走。 

7  Demo 例程演示 

 所有工程均位于光盘"\demo\StarterWare\Application"文件夹内。"demo\StarterWare"整
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个目录说明如下： 

 

\Application 参考程序源文件及工程文件 

\Binary \Application 目录中的参考程序编译出来的.out/.ais 文件，可以直

接加载/烧写 

\HostApp 上位机程序 

\Include C 语言头文件 

 \Include\DSPLib DSP C674x DSP 函数库函数

声明 

 \Include\MathLib DSP C674x 数学函数库函数

声明 

 \Include\StarterWare DSP C674x StarterWare 库函

数声明 

 \Include\StarterWare\Drivers DSP C674x StarterWare 驱动

库函数声明 

 \Include\StarterWare\Drivers\c674

x 

DSP C674x StarterWare 中

断、缓存库函数声明 

 \Include\StarterWare\Drivers\hw DSP C674X StarterWare 寄存

器定义 

 \Include\StarterWare\Grlib TI 图形库函数声明 

 \Include\StarterWare\NandLib TI Nand Flash 库函数声明 

 \Include\StarterWare\UsbLib TI USB 库函数声明 

\Library 库文件 ELF 格式，要引用这些库工程.out 文件必须选择编译成

ELF 格式 

 \Library\DSPLib DSP C674x DSP 函数库 

 \Library\MathLib DSP C674x 数学函数库 

 \Library\Platform  
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 \Library\StarterWare\Drivers DSP C674x StarterWare 驱动

库 

 \Library\StarterWare\Grlib TI 图形库 

 \Library\StarterWare\NandLib TI Nand Flash 库 

 \Library\StarterWare\SystemConfi

g 

TI SystemConfig 库（中断及

缓存） 

 \Library\StarterWare\UsbLib TI USB 库 

 \Library\StarterWare\Utils 辅助工具库（串口终端、命

令行、ASCII 处理等） 

\TargetConfig 仿真器配置文件，可以复制/创建链接到工程中，也可以在 CCS

指定该路径 

\Tronlong_C6748.gel 用于初始化的 gel 文件脚本，TargetConfig 文件中默认引用该文

件 

 

 在安装 StarterWare 后，可在安装目录下找到 C6748 的所有库函数的源码，同时可在

安装目录 docs 文件夹内找到所有库函数的使用方法。 

7.1 GPIO_LED——GPIO 输出（LED 灯） 

 此程序的作用是实现 GPIO 输出功能。按照工程导入步骤加载 GPIO_LED.out 文件，

然后点击程序运行 按钮。 

演示现象 

（1） 底板 LED 循环点亮。 

7.2 GPIO_KEY——GPIO 输入（按键中断） 

 此程序的作用是实现 GPIO 输入功能。按照工程导入步骤加载 GPIO_KEY.out 文件，

然后点击程序运行 按钮。 
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演示现象 

（1） 按下 SW6 按键将标志 Flag 置 1 ，核心板 LED 开始循环点亮。 

（2） 按下 SW5 按键将标志 Flag 置 0 ，核心板 LED 停止循环点亮。 

7.3 TIMER——定时器 

 此程序的作用是实现定时器功能，此处使用的是定时器 2。DSP C6748 有 4 个定时器

/计数器，均可配置为 64 位计数器、两个独立 32 位计数器及自动重装 32 位计数器，可

以产生周期中断 DMA 事件及外部事件。定时器/计数器还可以用于捕获外部输入信号边

缘并计数。此外，定时器 1 还可以用作 64 位看门狗计数器。 

 按照工程导入步骤加载 TIMER.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 核心板 LED 间隔 1 秒循环点亮。 

 时钟为 PLL0_SYSCLK2=CPU 频率/2=456MHz/2=228MHz，所以时间间隔: 

T=计数周期*（1/PLL0_SYSCLK2）=0x0D970100/228000000s=1s 

 0x0D970100 是程序中设定的计数周期。 

7.4 UART0_INT——UART0 串口中断收发 

此程序的作用是实现串口 0 中断方式数据收发功能, 由于使用 TL6748-EVM 测试

UART0 不方便，因此此处使用 TL6748-EasyEVM 演示。 

 按照工程导入步骤加载 UART0_INT.out 文件，将开发板的 UART0 和 PC 机连接，打

开串口调试终端，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控

制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印提示信息，如下图所示： 
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图 62 

 

（2） 使用键盘输入任意字符，CPU 会将接收到的字符回显到串口调试终端，如下图所

示： 

 

 

图 63 

 

7.5 UART1_POLL——UART1 串口查询收发 

 此程序的作用是实现串口 1 查询方式数据收发功能。 

 按照工程导入步骤加载 UART1_POLL.out 文件，将开发板的 UART1 和 PC 机连接，

打开串口调试终端，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流

控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印提示信息，如下图所示： 
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图 64 

 

（2） 使用键盘输入任意字符，CPU 会将接收到的字符回显到串口调试终端，如下图所

示： 

 

 

图 65 

 

7.6 UART2_INT——UART2 串口中断收发 

 此程序的作用是实现串口 2 中断方式数据收发功能。 

 按照工程导入步骤加载 UART2_INT.out 文件，将开发板的 UART2 和 PC 机连接，打

开串口调试终端，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控

制无，然后点击程序运行 按钮。 

演示现象 

（3） 串口调试终端会打印提示信息，如下图所示： 
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图 66 

 

（4） 使用键盘输入任意字符，CPU 会将接收到的字符回显到串口调试终端，如下图所

示： 

 

 

图 67 

 

7.7 RS485——RS485 串口查询收发 

 此程序的作用是实现 RS485 串口查询方式数据收发功能，此处 RS485 和 UART1 复

用。 

 按照工程导入步骤加载 RS485.out 文件，硬件连接方法： 

（1） 通过USB转串口线和RS232-RS485转接头将开发板的RS485串口和PC机连接； 

（2） 底板 RS485 接口的 A 接 RS232-RS485 转接头的"+"； 

（3） 底板 RS485 接口的 B 接 RS232-RS485 转接头的"-"； 
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（4） 底板 RS485 接口的 GND 接 RS232-RS485 转接头的 GND； 

（5） RS232-RS485 转接头的接上 5V 电源，可使用开发板上 J3 连接器上的 1 脚； 

 打开串口调试终端，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，

流控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印提示信息，如下图所示： 

 

 

图 68 

 

（2） 使用键盘输入任意字符，CPU 会将接收到的字符回显到串口调试终端，如下图所

示： 

 

 

图 69 

7.8 IIC_EEPROM——IIC EEPROM 读写 
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 此程序的作用是实现 IIC EEPROM 设备的数据读写功能，地址是 0x50（高 7 位）。 

 按照工程导入步骤加载 IIC_EEPROM.out 文件，将开发板的 UART2 和 PC 机连接，

打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流

控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印如下信息： 

 

 

图 70 

 

 此程序先写入并读出一个字节数据，然后写入并读出一页数据，接着对比写入和读出

的数据，根据结果判断 IIC EEPROM 设备读写是否成功。 

7.9 SPI_FLASH——SPI FLASH 读写 

 此程序的作用是实现 SPI FLASH 设备的数据读写功能，此设备使用 SPI1 总线 CS0

片选。 

 按照工程导入步骤加载 SPI_FLASH.out 文件，将开发板的 UART2 和 PC 机连接，打

开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控
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制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印如下信息： 

 

 

图 71 

 

 此程序先提示是否擦除 SPI FLASH，输入 y 擦除 SPI FLASH 上的数据，然后对比写

入和读出的数据，根据结果判断 SPI FLASH 设备读写是否成功。 

7.10 WatchDog——看门狗 

 此程序的作用是实现看门狗功能，使用定时器 1。用于在程序运行过程中出现错误或

陷入死循环等异常情况下复位程序。此程序设定看门狗超时时间为 5s。程序运行后在 5s

内输入任意字符，程序会持续运行，否则系统将复位。 

 按照工程导入步骤加载 WatchDog.out 文件，将开发板的 UART2 和 PC 机连接，打开

串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制

无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印提示信息，若在 5s 内无任何信息输入将复位系统。由于在
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仿真加载模式下，复位后程序不会自动运行，故只会打印一次信息。若将程序烧写到

NAND FLASH 后，并在 NAND FLASH 档位启动系统，系统复位后程序会再次运行，

将会持续打印提示信息，如下图所示： 

 

 

图 72 

 

 定时器1时钟来源于PLL旁路时钟，即晶体振荡器时钟24MHz，所以看门狗时间间隔： 

T=计数周期*（1/24MHz）=0x07270E00/24000000s=5s 

 0x07270E00 是程序中设定的计数周期。 

 

7.11 NMI——不可屏蔽中断 

 此程序的作用是实现不可屏蔽中断功能。NMI (Non Maskable Interrupt)——不可屏蔽

中断(即 CPU 不能屏蔽)，无论状态寄存器中 IF 位的状态如何，CPU 收到有效的 NMI 必

须进行响应。 

 按照工程导入步骤加载 NMI.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 每按一下不可屏蔽中断按键（SW4），CPU 就响应 NMI 去将核心板的 LED 轮流
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点亮。 

7.12 PWM——高精度脉冲宽度调制器 PWM 输出 

 此程序的作用是实现 eHRPWM（高精度脉冲宽度调制器）输出功能。TMS320C6748

共有两个 eHRPWM 模块，此处测试模块 1 的 EPWM1_A 引脚。由于使用 TL6748-EVM

测试 eHRPWM 不方便，因此使用 TL6748-EasyEVM 演示。 

 按照工程导入步骤加载 PWM.out 文件，然后点击程序运行 按钮。 

 用示波器探头测 TL6748-EasyEVM 底板上的 J2 排针第 7 引脚（EPWM1_A），示波

器的地接在 SD 卡卡座上（地），如下图所示： 

 

 

图 73 

 

 

图 74 
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图 75 

 

 可在示波器上看到看到频率为 10kHz、占空比为 50%的方波，如下图所示： 

 

 

图 76 

 可以通过修改程序中的函数 PWM1ABasic(10000,50)的参数，对 PWM 波输出的频率

和占空比进行修改，"10000"代表频率 10KHz，"50"代表占空比 50%。也可以取消对

ChopperWaveform()的注释，在 EPWM1_A 管脚获得更高频率的斩波输出。 

7.13 ECAP_APWM——增强型捕获模块 ECAP 辅助输出 

 此程序的作用是实现 eCAP（增强型捕获模块）的 APWM（辅助脉冲宽度调制器）输

出功能。由于使用 TL6748-EVM 测试 eCAP 不方便，因此使用 TL6748-EasyEVM 演示。 
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 TMS320C6748 共有三个 eCAP 模块，此处测试模块 3 的 ECAP2_APWM2 引脚。可

在核心板引脚说明表中看到 ECAP2_APWM2 和 EPWMN0_TZ[0]引脚功能复用，如下图

所示： 

 

 

图 77 

 

 

图 78 

 

 按照工程导入步骤加载 ECAP_APWM.out 文件，然后点击程序运行 按钮。 

 用示波器探头测 TL6748-EasyEVM 底板上的 J2 排针第 3 引脚（ECAP2_APWM2），

示波器的地接在 SD 卡卡座上（地），可以在示波器上看到看到周期 10KHz、占空比为

50%的方波，如下图所示： 



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  59/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
 

 

图 79 

 

 通过修改Period和DutyCycle来改变频率和占空比。Period是比较器的数值，DutyCycle

是占空比。宏定义代码如下： 

#define Period 22800 //周期计数 

 

#define DutyCycle 0.5 //占空比 

 

 以下为 eCAP 输出频率计算公式： 

（1） eCAP 模块频率=CPU 频率/2=456MHz/2=228MHz 

（2） eCAP 周期=Period*（1/eCAP 模块频率）=22800/(228MHz) 

（3） eCAP 输出频率=1/eCAP 周期=228MHz/22800=10KHz 

 可在程序中取消对"#define SELECT_LED"注释，重新编译和加载程序，测试 GPIO0_0

引脚（和 ECAP1_APWM1 引脚复用），该引脚和底板 LED D7 灯为同一引脚，可以实现

通过 APWM 调节底板 LED D7 的亮灭（注意：APWM 波的输出频率不能设置太高，否

则看不到 LED 的变化）。 

7.14 PWM_ECAP——增强型捕获模块 ECAP 捕获 
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 此程序的作用是实现 eCAP（增强型捕获模块）输入捕获功能，将 ECAP2_APWM2

设置为输入捕获模式，检测由 EPWM1_A 管脚输出的方波频率。由于使用 TL6748-EVM

测试不方便，因此使用 TL6748-EasyEVM 演示。 

 将 TL6748-EasyEVM 底板上 J2 排针的第 3 和第 7 管脚短接，即将 EPWMN0_TZ[0]

（ECAP2_APWM2 和 EPWMN0_TZ[0]引脚功能复用）和 EPWM1_A 短接，如下图所示： 

 

 

图 80 

 

 按照工程导入步骤加载 PWM_ECAP.out 文件，将开发板的 UART2 和 PC 机连接，打

开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控

制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会分别打印 PWM 和 eCAP 产生和捕获到的相关参数，单位是 Hz，

如下图所示。 
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图 81 

 

 可以通过修改函数 PWM1ABasic(25000,50)的频率值，重新验证程序。其中"25000"

是 PWM 输出信号频率，"50"是 PWM 输出信号占空比。 

 PWM 模块输出频率有些偏差，但 ECAP 模块捕获到的 PWM 实际频率较为准确。以

下是 PWM 理论输出频率和实际输出频率的对比： 

 

 

图 82 

7.15 RTC——RTC 时钟 

 此程序的作用是实现 RTC 计时功能 

 按照工程导入步骤加载 RTC.out 文件，将开发板的 UART2 和 PC 机连接，打开串口

调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，

然后点击程序运行 按钮。 

演示现象 
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（1） 串口调试终端会打印如下信息，请依次设定小时、分钟、秒、日、月、年，程序

会按照设定时间开始计时，并将实时时间打印出来。以此时间为例：17 点 23 分 00

秒，2014 年 6 月 7 日，星期六。 

 

 

图 83 

 

 RTC 时钟来源于 PLL 旁路时钟，即晶体振荡器时钟 24MHz。 

7.16 LCD——LCD 显示 

 此程序的作用是实现 LCD 显示功能，程序会调用 grLib 图形库显示各种图形元素，

 按照工程导入步骤加载 LCD.out 文件，将开发板的 UART2 和 PC 机连接，打开串口

调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，

然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印如下信息： 
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图 84 

 

（2） LCD 会显示图片。 

更改显示图像方法 

 准备好 bmp 格式图形文件（例如 tronlong.bmp），将其拷贝到 StarterWare 安装路径

中的 tools\bmp2c 目录下。若 StarterWare 安装在默认路径，路径是： 

C:\ti\C6748_StarterWare_1_20_04_01\tools\bmp2c 

 在 Windows 开始菜单底部输入 cmd 进入控制台窗口，进入此 bmp2c 目录并执行图片

转化命令，会生成图形文件的字符数组 C 文件 image.c，命令如下： 

DOS#  cd C:\ti\C6748_StarterWare_1_20_04_01\tools\bmp2c 

DOS# bmp2c -8 tronlong.bmp image.c 
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图 85 

 

 打开 image.c，在该文件头加入头文件申明"#include "grlib.h""，如下图所示： 

 

 

图 86 

 

 最后把 image.c 文件拷贝至 LCD 工程根目录下覆盖原有图像文件 image.c，重新编译

并运行程序即可。建议图片不能太大，否则会影响编译、加载、烧写的时间。 

7.17 TOUCH——触摸屏 

 此程序的作用是实现 LCD 触摸功能，可以进行点击与画线。 
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按照工程导入步骤加载 TOUCH.out 文件，将开发板的 UART2 和 PC 机连接，打开串

口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，

然后点击程序运行 按钮。 

演示现象 

（1） 点击屏幕串口调试终端会打印如下坐标信息： 

 

 

图 87 

 

7.18 MMCSD——SD 卡读写 

 此程序实现了通过 MMCSD0 接口对 SD 卡进行块数据读写。该测试会破坏 SD 卡原

有的内容，请在做测试之前请做好数据备份工作。 

 按照工程导入步骤加载 MMCSD.out 文件，将开发板的 UART2 和 PC 机连接，打开

串口调试终端，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制

无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印提示信息，说明数据读写成功。 
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7.19 USB_DEV_BULK——USB OTG 从方式（USB BULK 管道通信） 

此程序的作用是演示 USB 从方式，通过 USB BULK 管道实现主机和 TMS320C6748

开发板的数据交换。 

首先连接开发板的 USB OTG 和 PC 机 USB 接口，接着在 PC 机中安装 USB 驱动程

序，具体驱动程序是在光盘"demo\StarterWare\HostApp\USB_DEV_BULK\driver"目录下的

installer_x64.exe 和 installer_x86.exe 两个文件。前者是 64 位 Windows 系统驱动，后者是

32 位 Windows 系统驱动，双击安装，安装过程很短，一闪而过。 

 按照工程导入步骤加载 USB_DEV_BULK.out 文件，将开发板的 UART2 和 PC 机连

接，打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，

流控制无，然后点击程序运行 按钮。 

检查 PC 设备管理器中是否枚举到 USB 设备"General Bulk Device"，如下图所示。 
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图 89 

 

如果显示为"Generic Bulk Device"或者未知设备设备。请右击此设备，在弹出的菜单

中选择“更新驱动程序软件”，如下图所示：  

 

 

图 90 

 

 在弹出的界面中选择“浏览计算机以查找驱动程序软件”，如下图所示： 
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 在弹出的界面中选择光盘"demo\StarterWare\HostApp\USB_DEV_BULK\driver"路径，

然后点击下一步，会弹出如下界面，然后点击安装。 

 

 

图 92 

 

 安装成功会弹出如下界面。 
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图 93 

 

 将光盘"demo\StarterWare\HostApp\USB_DEV_BULK\usb_bulk_test"测试程序源码整

个目录复制到 C 盘根目录下，在 Windows 开始菜单底部输入 cmd 进入控制台窗口，进入

此 usb_bulk_test 下的 debug 目录并执行测试程序，命令如下： 

DOS#  cd C:\usb_buk_test\debug 

DOS# usb_buk_test.exe 

演示现象 

（1） PC 机控制台窗口显示读写数据成功信息。 
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图 94 

 

（2） 串口调试窗口输出提示信息。 

 

 

图 95 

 

（3） 屏幕提示开发板和 PC 通信成功，并显示已成功传输字节数量。 
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UI 程序演示  

 为了方便使用，TMS320C6748 开发板的光盘中提供了一个 UI 程序。 

 源码和可执行程序分别位于光盘如下路径： 

demo\StarterWare\HostApp\USB_DEV_BULK\bulk_test_ui 

demo\StarterWare\HostApp\USB_DEV_BULK\bulk_test_ui\debug\bulk_test_ui.exe 

 

 

图 96 

 

 双击可执行程序 bulk_test_ui.exe（如果执行有错误，请使用 VS2005 重新编译并生

成.exe 文件），弹出如下界面： 

 

 

图 97 

 

 点击“打开设备”，然后点击“读写设备”，界面显示如下： 
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 UI 程序将十六进制数据 00~3f 共 64 个数据通过 USB 送往开发板，然后再读取回来，

显示在 UI 界面上。 

USB Tracer 捕获工具的使用 

 为了更清楚的是看到 USB 数据的传输，可以使用 USBTrace 工具。USBTrace 是一款

功能强大的USB监控软件，它能够分析USB总线和与之相连的USB设备的的连接状况，

监控包括 USB 控制器，USB 集线器和 USB 设备的连接，请求和运行情况。具备 USB 包

抓取，USB 设备类别分析等功能，适合检测主机方的 USB 控制协议。 

 该工具在"demo\StarterWare\HostApp\tools\USBTrace_Installer"目录下，先安装原程序，

然后将 Crack 目录下的所有内容覆盖到安装目录中。 

USBTrace_x64_Build_77_220512_Installer：64 位 Windows 系统驱动； 

USBTrace_x86_Build_77_220512_Installer：32 位 Windows 系统驱动； 

 确保开发板正常启动、USB 驱动已正常安装、UI 正常启动，然后点击桌面的 USBTrace

图标，弹出如下界面： 
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 选择需要捕获的 USB 设备"Generic Bulk Device"，如下图所示： 

 

 

图 100 

 

设置过滤器并开始捕获，点击步骤按照 1->2->3->4->5，如下图所示： 
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 然后点击 bulk_test_ui 界面的“读写设备”按钮，可发现 USBTrace 右边显示如下图： 

 

 

图 102 

  

 点击 OUT 或者 IN 行即可在下方看到发送或者接收到的数据，如下图所示： 
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7.20 USB_DEV_MSC——USB OTG 从方式（虚拟存储设备） 

此程序的作用是演示 USB 从方式，将 TMS320C6748 开发板模拟成一个 USB 存储设

备，实现主机和开发板之间的数据传输。 

 按照工程导入步骤加载 USB_DEV_MSC.out 文件，连接开发板的 USB OTG 和 PC 机

USB 接口，然后点击程序运行 按钮，弹出如下格式化提示界面： 

 

 

图 104 

 

点击“格式化磁盘”，弹出如下界面： 
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 点击“开始”，弹出如下界面： 

 

 

图 106 

  

 点击“确定”，弹出如下界面： 

 

 

图 107 
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 可以在 PC 中看到新产生约 48MByte 大小的可移动磁盘盘符，如下图所示： 

 

 

图 108 

 

可以像操作普通的 U 盘一样操作此磁盘。请保持开发板状态和连接，进行下面的速

度测试步骤。 

传输速度测试 

双击光盘 "demo\StarterWare\HostApp\tools\ATTO_Disk_Benchmarks_V2.47_CN.exe"

文件，弹出如下界面。选择磁盘（此处识别为 I 盘），选择 32MByte 空间，然后点击“开

始”按钮： 
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 等待 3 分钟左右，可以在界面中看到 0.5KByte~8MByte 文件读写速度测试结果，如

下图所示： 
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 可从图中看到当传输文件达到 64KByte 以上，读和写速度可以分别稳定在 24MByte/S

和 23MByte/S 左右。 

7.21 USB_DEV_SERIAL——USB OTG 从方式（USB 虚拟串口） 

 此程序的作用是演示 USB 从方式，实现 USB 虚拟串口功能。 

 按照工程导入步骤加载 USB_DEV_SERIAL.out 文件，通过 OTG 将开发板和 PC 机

USB 接口连接，将开发板的 UART2 和 PC 机连接，打开串口调试软件，设置好波特率为

115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

 可以发现识别为 USB 为虚拟串口，如下图所示： 
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 若无法识别，请仿照 USB_DEV_BULK 相关步骤手动更新驱动，驱动位于资料光盘

"demo\StarterWare\HostApp\tools\USB_DEV_SERIAL_DRIVER"目录下。由于 ZOC 串口调

试终端无法识别大编号串口，请在“设备->端口”中右击虚拟设备，弹出如下界面： 

 

 

图 112 

 

 点击“属性”，弹出如下界面： 
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 点击“端口设置->高级”，如下图所示：  

 

 

图 114 
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 弹出如下界面，在“COM 端口号（P）”处选择一个空闲的 COM 口，然后点击确定。 

 

 

图 115 

 

 打开一个新的串口调试终端窗口，选择上面空闲的 COM 口，设置好波特率为 115200，

数据位 8 位，停止位 1 位，检验位无，流控制无。在任意一个窗口输入字符，可以在另

外一个窗口看到字符输出。 

 

 

图 116 

  

7.22 USB_HOST_KEYBOARD——USB OTG 主方式（USB 键盘） 
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 此程序的作用是演示 USB HOST 方式，实现 USB 键盘输入功能。  

 按照工程导入步骤加载 USB_HOST_KEYBOARD.out 文件，通过 OTG 转接头将 USB

键盘和开发板 USB OTG 接口连接，然后点击程序运行 按钮。 

演示现象 

（1） 开发板检测到 USB 键盘后，会在屏幕左下角出现"Connected"字符，可以通过键

盘输入字符显示到屏幕，并支持换行。拔出设备后屏幕左下角出现"No Device"字符。 

7.23 USB_HOST_MOUSE——USB OTG 主方式（USB 鼠标） 

 此程序的作用是演示 USB HOST 方式，实现 USB 鼠标功能。  

 按照工程导入步骤加载 USB_HOST_MOUSE.out 文件，通过 OTG 转接头将 USB 鼠

标和开发板 USB OTG 接口连接，然后点击程序运行 按钮。 

演示现象 

（1） 开发板检测到 USB 鼠标后，会在屏幕左下角出现"Connected"字符，拔出设备后

屏幕左下角出现"No Device"字符。移动鼠标可以在屏幕上看到白色光标滑动，按住

鼠标可以在屏幕上画点画线，松开鼠标并滑动可以擦除相应位置的点线。屏幕右下角

可以显示按键状态。 

7.24 USB_HOST_MSC——USB OTG 主方式（U 盘内容查看） 

 此程序的作用是演示 USB HOST 方式，实现 TMS320C6748 开发板对 U 盘的查看。

 按照工程导入步骤加载 USB_HOST_MSC.out 文件，通过 OTG 转接头将 U 盘接到开

发板的 OTG 接口，将开发板的 UART2 和 PC 机连接，打开串口调试软件，设置好波特

率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按

钮。 

 若在串口调试终端有打印信息"Mass storage device connected."，说明 CPU 已发现 U

盘并连接成功，如下图所示： 
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 此处串口作用类似于 Linux 的串口终端后台，输入"h"并回车可查看已实现的后台命

令，如下图所示： 

 

 

图 118 

 

ls：查看 U 盘内容 

chdir：改变目录路径 

cd：进入目录 

pwd：打印当前目录路径 

cat：查看文件内容 
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 例如输入"ls"，可查看到 U 盘内容，如下图所示： 

 

 

图 119 

 

7.25 ENET_HTTPD——网络 Web 服务器 

 此程序的作用是实现网络通信功能，在 TMS320C6748 开发板上搭建一个轻量级 Web

服务器。连接好网线（注意：接路由器用直连网线，直连 PC 则用交叉网线），将开发板

的 UART2 和 PC 机连接，打开串口调试软件，设置好波特率为 115200，数据位 8 位，停

止位 1 位，检验位无，流控制无。 

 按照工程导入步骤加载 ENET_HTTPD.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 串口显示开发板的 IP 地址（192.168.1.200）。 
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图 120 

 

（2） 在 Windows 开始菜单底部输入 cmd 进入控制台窗口，执行 ping 命令，确认开发

版网络部分工作正常。 

DOS#  ping 192.168.1.200 

 

 

图 121 

 

（3） 打开浏览器输入网址 http://192.168.1.200，就可以看到网址内容。 

http://192.168.1.200/
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图 122 

 

（4） IP 修改方法 

修改文件 lwipopts.h 文件如下行对应位： 

#define STATIC_IP_ADDRESS  0xC0A801C8 

 其中 0xC0A801C8 为 16 进制，对应 IP：192.168.1.200，对应位的意思是： 

C0：192 

A8：168 

01:1 

C8:200 

 请根据个人需求修改即可。 

7.26 ENET_ECHO——网络 Socket 通信 

 本程序主要演示 Socket 通信，开发板为服务器，PC 机为客户端，两者实现数据交换。

 首先连接好网线，连接接好网线（注意：接路由器用直连网线，直连 PC 则用交叉网
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线），将开发板的 UART2 和 PC 机连接，打开串口调试软件，设置好波特率为 115200，

数据位 8 位，停止位 1 位，检验位无，流控制无。 

 按照工程导入步骤加载 ENET_ECHO.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 串口显示开发板的 IP 地址（192.168.1.200）和端口（2000），如下图所示： 

 

 

图 123 

  

UI 程序演示  

 首先在 Windows 开始菜单底部输入 cmd 进入控制台窗口，执行 ping 命令，确认开发

版网络部分工作正常。 

DOS#  ping 192.168.1.200 
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图 124 

 

 双击光盘 "demo\StarterWare\HostApp\ENET_ECHO\enet_client\debug\enet_client.exe"

即可运行 UI 程序（假如出错请用 VS2005 重新编译，并再次运行），弹出如下界面： 

 

 

图 125 

 

 UI 程序可以选择单次发收，也可以选择多次发收，发送的数据内容用户可以在程序

中自行修改，程序会对发送和接收的内容进行比对校验。点击“建立连接”后再点击“读

写测试”，弹出如下界面：  
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图 126 

 

Wireshark 捕获工具的使用 

 

 Wireshark 是一个网络封包分析软件。网络封包分析软件的功能是撷取网络封包，并

尽可能显示出最为详细的网络封包资料。 

 Wireshark 软件的路径位于光盘如下路径： 

demo\StarterWare\HostApp\tools\Wireshark-win32-1.10.3.exe 

 请双击安装此软件。正确安装后打开 Wireshark 软件，如下图所示： 

 

http://baike.baidu.com/view/6102086.htm
http://baike.baidu.com/view/37.htm
http://baike.baidu.com/view/6102086.htm
http://baike.baidu.com/view/37.htm
http://baike.baidu.com/view/6102086.htm
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图 127 

 

 接着按下图步骤 1->2->3 点击，如下图所示： 

 

 

图 128 

 

 点击 Start 后，弹出如下界面： 
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图 129 

 

 然后按下图步骤1->2->3点击并在步骤 2中设置需要监控的 IP地址为 192.168.1.200，

如下图所示： 

    

 

图 130 
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 点击 OK 后弹出如下界面： 

 

 

图 131 

 

 然后点击 UI 程序中的“读写测试”按钮或者在 PC 中执行"ping 192.168.1.200"命令，

Wireshark 会打印监听到的信息，如下图所示： 

  

 

图 132 
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图 133 

 

7.27 AUDIO_LINE_OUT——Line Out 音频输出 

 此程序的作用是实现 Line out 音频播放功能，主要演示如何设置 McASP 和 AIC 芯片

来播放一段原始音频数据。 

 按照工程导入步骤加载 AUDIO_LINE_OUT.out 文件，将开发板的 UART2 和 PC 机

连接，打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位

无，流控制无，然后点击程序运行 按钮，在 Line out 接口插上耳机。 

演示现象 

（1） 串口调试终端会打印如下信息： 
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图 134 

 

（2） 耳机重复播放一段声音。 

7.28 AUDIO_MIC_IN——Mic In 音频输入 

 此程序的作用是将从 Mic In 接口输入的音频数据送到 Line Out 接口播放。 

 按照工程导入步骤加载AUDIO_MIC_IN.out文件，将开发板的UART2和PC机连接，

在 Line Ou CON11 接口插上耳机或者喇叭，在 Mic In CON10 接口插上 QQ 聊天使用的麦

克风，打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位

无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印如下信息： 

 

 

图 135 

 

（2） 对着麦克风说话的时候，可以在耳机或者喇叭听到声音。（注：由于耳机声音较

小，可能无法听到声音，建议使用喇叭。） 

7.29 AUDIO_LINE_IN——Line In 音频输入 
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 此程序的作用是将从 Line In 接口输入的音频数据送到 Line Out 接口播放。 

 按照工程导入步骤加载 AUDIO_LINE_IN.out 文件，将开发板的 UART2 和 PC 机连

接，在Line Out CON11接口插上耳机或者喇叭。准备一条3.5mm两头均为公头的音频线，

一头接着开发板的 Line In CON18 音频接口，另外一端接在播放着歌曲的播放器（手机

或者 PC 均可）。打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1

位，检验位无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印如下信息： 

 

 

图 136 

 

（2） 可以在耳机或者喇叭听到播放器播放的声音。 

7.30 McBSP——McBSP 总线数据收发 

 此程序的作用是实现 McBSP 接口的数据收发功能，将 McBSP 发出去的数据直接采

集回来。由于使用 TL6748-EVM 测试 McBSP 不方便，因此使用 TL6748-EasyEVM 演示。 

 按照工程导入步骤加载 McBSP.out 文件，将开发板的 UART2 和 PC 机连接。将底板

J4 排针的 McBSP0 的数据发送引脚和接收引脚短接，发送帧同步信号和接收帧同步信号

短接，即 McBSP0_DX0 和 McBSP0_DR0 短接，McBSP0_FSX0 和 McBSP0_FSR0 短接。

如下图所示： 
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图 137 

 

 打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，

流控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印如下发送的数据信息，说明数据传输成功。 
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图 138 

 

7.31 VPIF_OV2640——VPIF 总线 CMOS 摄像头数据采集 

 此程序实现了使用 VPIF 总线去采集 OV2640 摄像头模组的数据并显示在 LCD 上。

更多 OV2640 的信息请查阅创龙 CMOS 摄像头模块 TL2640 规格书。 

 按照工程导入步骤加载 VPIF_OV2640.out 文件，将开发板的 UART2 和 PC 机连接。

将 TL2640 模块插到开发板底板的 J3 接口。切勿连接到底板 J2 接口，否则可能会烧坏模

块，同时检查是否左右偏移。连接如下图所示： 
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图 139 

 

 打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，

流控制无，然后点击程序运行 按钮。 

演示现象 

（1） 串口调试终端会打印 CMOS 摄像头 ID 信息，如下图所示： 

 

 

图 140 

 

（2） LCD 上会显示采集到的图像。 

7.32 EMIF_AD7606——EMIF 总线 8 通道并口 AD 数据采集 



 

销售邮箱：sales@tronlong.com  技术邮箱：support@tronlong.com  DSP 论坛：www.51dsp.net  

公司总机：020-8998-6280      公司官网：www.tronlong.com                  100/140 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
 此程序实现了使用 EMIF 总线去读写 AD7606 AD 芯片。AD7606 是 8 通道、16Bit、

200K 采样率的 AD 芯片，支持并口/串口读写方式，模块默认为并口模式，采用并口模式

采样率可到达 200K 的采样率，采用 SPI 模式采样率只有 100K 左右。强烈建议使用并口

模式，这样才能真正发挥 8 通道 AD7606 的同步采样性能。支持±10V 或±5V 的双极性信

号输入，在电力、仪器仪表等行业应用广泛。更多信息请参考创龙 AD7606 数据采集模

块 TL7606 规格书。 

  通过AD7606数据采集模块TL7606的 J1的跳帽设置输入电压的范围为±10V或±5V。

接 0 设置范围为±5V，接 1 设置范围为±10V。电路图如下： 

 

 

图 141 J1 连接器引脚定义 

 

   

（1） 连接开发板 

 将 TL7606 模块插到开发板底板的 J2 接口，如下图所示。切勿连接到底板 J3 接口，

否则会烧坏模块，同时检查是否左右偏移。 
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图 142 

 

（2） 接入电压信号和供电电源 

 将需要采集的电压信号接到对应通道,另一端接到对应的地，例如接到 V1 和 V1GND。 

上层信号：V1、V2、V3、V4、V5、V6、V7、V8（按顺序从左到右）； 

下层信号：V1GND、V2GND、V3GND、V4GND、V5GND、V6GND、V7GND、V8GND

（按顺序从左到右）。 

 同时使用 5V 2A 电源适配器给模块供电。如下图所示： 
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图 143 

 

  注意：输入电压不能超出已设置的电压范围，否则可能会损坏模块。此处为了测试方

便，地只接了 1 个通道的地，8 个通道的地内部是连通的，也将 8 个通道的输入端同时接

到了同一个数字输入电源。 

（3） 启动开发板 

 按照工程导入步骤加载 EMIF_AD7606.out 文件，将开发板的 UART2 和 PC 机连接，

打开串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流

控制无，然后点击程序运行 按钮。 

（4） 读取 AD 采样值 

 串口终端会有类似如下的信息打印出来。 
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图 144 

 

理论值计算方法 

  例如输入 2.0V 时，得到的理论值： 

Value=32768*2.0/5.0=13107 

  如需 C6748 与 FPGA 通过 EMIF 通信的源程序和参考设计电路，见与 C6748 配套的

FPGA 高速数据采集板卡光盘资料。 

7.33 EDMA3——EDMA3 一维数据传输 

  此程序的作用是实现了第三代增强型直接内存存取 EDMA3 一维数据传输功能，此处

使用的例子是数组的拷贝。 

  按照工程导入步骤加载 EDMA3.out 文件，然后点击程序运行 按钮。 

（1） 串口调试终端会打印信息，如下图所示： 
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图 145 

7.34 EDMA3_TRANSPOSE——EDMA3 二维数据传输  

  此程序的作用是实现了第三代增强型直接内存存取 EDMA3 二维数据传输功能，此处

使用的例子是二维矩阵的行列转置。 

  按照工程导入步骤加载EDMA3_TRANSPOSE.out文件，然后点击程序运行 按钮。 

（1） 串口调试终端会打印矩阵转置信息，如下图所示： 

 

 

图 146 
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7.35 uPP——uPP 数据收发 

 如需 C6748 与 FPGA 通过 uPP 接口通信的源程序和参考设计电路，请购买与 C6748

配套的 FPGA 高速数据采集板卡。 

7.36 SATA——SATA 读写 

 Coming Soon. 

7.37 FFT——快速傅里叶变换/逆变换（不开缓存） 

 此程序的作用是实现 FFT 处理功能，但是没有打开缓存。 

 按照工程导入步骤加载 FFT.out 文件，然后点击程序运行 按钮。 

 CCS 支持绘制多种类型的图表时域图、频域图、瀑布图等等。待测试信号为原始信

号做 1K 采样频率进行 1024 个点抽样得到。 

信号源公式：y=5*sin(2*pi*150*t)+15*sin(2*pi*350*t) 

 该信号含有 150Hz和 350Hz两种频率分量。 

演示步骤现象 

 点击"Tools->Graph->Single Time"选择单时域信号图，如下图所示： 
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图 147 

 

 按照下图进行设置： 
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图 148 

 

 点击 OK，CCS 界面底部弹出如下界面： 
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图 149 

 

 MATLAB 代码 FFT.m 位于光盘 demo\Application\FFT 目录下，程序如下图： 

 

 

图 150 
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 MATLAB图表如下图： 

 

 

图 151 

 

 经对比可以看出经过 DSP C6748 计算的结果与 MATLAB 计算结果一致。 

7.38 FFT_Benchmark——快速傅里叶变换/逆变换（打开/关闭缓存速度对比） 

 此程序的作用是测试快速傅里叶变换/快速傅里叶逆变换处理速度。 

 按照工程导入步骤加载 FFT_Benchmark.out 文件，打开串口调试软件，设置好波特率

为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

信号源公式：y=2+3cos(2pi*50t-(30/180)pi)+1.5cos(2pi*75t+*(90/180)pi) 

演示现象 

（1） 串口会打印测试结果。 

Test signal 

-Include 2V DC Component 
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-Include 3V AC Component,Frequency:50Hz Phase:-30 Degree 

-Include 1.5V AC Component,Frequency:75Hz Phase:90 Degree 

-Formula:y=2+3cos(2pi*50t-(30/180)pi)+1.5cos(2pi*75t+*(90/180)pi) 

-------------------------------------------------- 

1: 8 Point FFT Test 

-Sampling Period:1s Sampling Frequency:8Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:54740 

-Forward Transformation Execution Time is 120 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:19340 

-Inverse Transformation Execution Time is 42 us (CPU Frequency:456MHz) 

8 Point FFT Test End 

-------------------------------------------------- 

2: 16 Point FFT Test 

-Sampling Period:1s Sampling Frequency:16Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:87584 

-Forward Transformation Execution Time is 192 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:36768 

-Inverse Transformation Execution Time is 80 us (CPU Frequency:456MHz) 

16 Point FFT Test End 

-------------------------------------------------- 

3: 32 Point FFT Test 

-Sampling Period:1s Sampling Frequency:32Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:178080 

-Forward Transformation Execution Time is 390 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:76528 

-Inverse Transformation Execution Time is 167 us (CPU Frequency:456MHz) 

32 Point FFT Test End 

-------------------------------------------------- 
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4: 64 Point FFT Test 

-Sampling Period:1s Sampling Frequency:64Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:359296 

-Forward Transformation Execution Time is 787 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:156756 

-Inverse Transformation Execution Time is 343 us (CPU Frequency:456MHz) 

64 Point FFT Test End 

-------------------------------------------------- 

5: 128 Point FFT Test 

-Sampling Period:1s Sampling Frequency:128Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:736104 

-Forward Transformation Execution Time is 1614 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:331420 

-Inverse Transformation Execution Time is 726 us (CPU Frequency:456MHz) 

128 Point FFT Test End 

-------------------------------------------------- 

6: 256 Point FFT Test 

-Sampling Period:1s Sampling Frequency:256Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:1475636 

-Forward Transformation Execution Time is 3236 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:666976 

-Inverse Transformation Execution Time is 1462 us (CPU Frequency:456MHz) 

256 Point FFT Test End 

-------------------------------------------------- 

7: 512 Point FFT Test 

-Sampling Period:1s Sampling Frequency:512Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:2967564 

-Forward Transformation Execution Time is 6507 us (CPU Frequency:456MHz) 
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-Inverse Transformation Execution Cycle is 0:1377836 

-Inverse Transformation Execution Time is 3021 us (CPU Frequency:456MHz) 

512 Point FFT Test End 

-------------------------------------------------- 

8: 1024 Point FFT Test 

-Sampling Period:1s Sampling Frequency:1024Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:5779008 

-Forward Transformation Execution Time is 12673 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:2727140 

-Inverse Transformation Execution Time is 5980 us (CPU Frequency:456MHz) 

1024 Point FFT Test End 

-------------------------------------------------- 

9: 2048 Point FFT Test 

-Sampling Period:1s Sampling Frequency:2048Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:11689464 

-Forward Transformation Execution Time is 25634 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:5711332 

-Inverse Transformation Execution Time is 12524 us (CPU Frequency:456MHz) 

2048 Point FFT Test End 

-------------------------------------------------- 

10: 4096 Point FFT Test 

-Sampling Period:1s Sampling Frequency:4096Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:23317528 

-Forward Transformation Execution Time is 51134 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:11448140 

-Inverse Transformation Execution Time is 25105 us (CPU Frequency:456MHz) 

4096 Point FFT Test End 

-------------------------------------------------- 
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11: 8192 Point FFT Test 

-Sampling Period:1s Sampling Frequency:8192Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:47896632 

-Forward Transformation Execution Time is 105036 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:24190248 

-Inverse Transformation Execution Time is 53048 us (CPU Frequency:456MHz) 

8192 Point FFT Test End 

-------------------------------------------------- 

12: 16384 Point FFT Test 

-Sampling Period:1s Sampling Frequency:16384Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:95890300 

-Forward Transformation Execution Time is 210285 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:48497568 

-Inverse Transformation Execution Time is 106354 us (CPU Frequency:456MHz) 

16384 Point FFT Test End 

-------------------------------------------------- 

13: 32768 Point FFT Test 

-Sampling Period:1s Sampling Frequency:32768Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:196861032 

-Forward Transformation Execution Time is 431712 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:102089868 

-Inverse Transformation Execution Time is 223881 us (CPU Frequency:456MHz) 

32768 Point FFT Test End 

-------------------------------------------------- 

14: 65536 Point FFT Test 

-Sampling Period:1s Sampling Frequency:65536Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:394094868 

-Forward Transformation Execution Time is 864243 us (CPU Frequency:456MHz) 
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-Inverse Transformation Execution Cycle is 0:204606164 

-Inverse Transformation Execution Time is 448697 us (CPU Frequency:456MHz) 

65536 Point FFT Test End 

-------------------------------------------------- 

15: 131072 Point FFT Test 

-Sampling Period:1s Sampling Frequency:131072Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:809104740 

-Forward Transformation Execution Time is 1774352 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:430023512 

-Inverse Transformation Execution Time is 943034 us (CPU Frequency:456MHz) 

131072 Point FFT Test End      

 

 以上是没有使能 L1、L2 缓存的测试结果。可以看到测试 128K 点正变换执行时间为

1774352 us ，逆变换执行时间为 943034 us。 

 将 main.c 文件以下代码去注释，就打开缓存了。 

 

 

图 152 

 

 重新编译和测试的数据如下： 

 

Test signal 

-Include 2V DC Component 

-Include 3V AC Component,Frequency:50Hz Phase:-30 Degree 

-Include 1.5V AC Component,Frequency:75Hz Phase:90 Degree 

-Formula:y=2+3cos(2pi*50t-(30/180)pi)+1.5cos(2pi*75t+*(90/180)pi) 
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-------------------------------------------------- 

1: 8 Point FFT Test 

-Sampling Period:1s Sampling Frequency:8Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:15464 

-Forward Transformation Execution Time is 33 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:4360 

-Inverse Transformation Execution Time is 9 us (CPU Frequency:456MHz) 

8 Point FFT Test End 

-------------------------------------------------- 

2: 16 Point FFT Test 

-Sampling Period:1s Sampling Frequency:16Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:18840 

-Forward Transformation Execution Time is 41 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:6556 

-Inverse Transformation Execution Time is 14 us (CPU Frequency:456MHz) 

16 Point FFT Test End 

-------------------------------------------------- 

3: 32 Point FFT Test 

-Sampling Period:1s Sampling Frequency:32Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:38388 

-Forward Transformation Execution Time is 84 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:13868 

-Inverse Transformation Execution Time is 30 us (CPU Frequency:456MHz) 

32 Point FFT Test End 

-------------------------------------------------- 

4: 64 Point FFT Test 

-Sampling Period:1s Sampling Frequency:64Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:78372 
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-Forward Transformation Execution Time is 171 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:29220 

-Inverse Transformation Execution Time is 64 us (CPU Frequency:456MHz) 

64 Point FFT Test End 

-------------------------------------------------- 

5: 128 Point FFT Test 

-Sampling Period:1s Sampling Frequency:128Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:157980 

-Forward Transformation Execution Time is 346 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:59936 

-Inverse Transformation Execution Time is 131 us (CPU Frequency:456MHz) 

128 Point FFT Test End 

-------------------------------------------------- 

6: 256 Point FFT Test 

-Sampling Period:1s Sampling Frequency:256Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:317304 

-Forward Transformation Execution Time is 695 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:121664 

-Inverse Transformation Execution Time is 266 us (CPU Frequency:456MHz) 

256 Point FFT Test End 

-------------------------------------------------- 

7: 512 Point FFT Test 

-Sampling Period:1s Sampling Frequency:512Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:636200 

-Forward Transformation Execution Time is 1395 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:245552 

-Inverse Transformation Execution Time is 538 us (CPU Frequency:456MHz) 

512 Point FFT Test End 
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-------------------------------------------------- 

8: 1024 Point FFT Test 

-Sampling Period:1s Sampling Frequency:1024Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:1274796 

-Forward Transformation Execution Time is 2795 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:493316 

-Inverse Transformation Execution Time is 1081 us (CPU Frequency:456MHz) 

1024 Point FFT Test End 

-------------------------------------------------- 

9: 2048 Point FFT Test 

-Sampling Period:1s Sampling Frequency:2048Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:2555388 

-Forward Transformation Execution Time is 5603 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:993012 

-Inverse Transformation Execution Time is 2177 us (CPU Frequency:456MHz) 

2048 Point FFT Test End 

-------------------------------------------------- 

10: 4096 Point FFT Test 

-Sampling Period:1s Sampling Frequency:4096Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:5126152 

-Forward Transformation Execution Time is 11241 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:2005052 

-Inverse Transformation Execution Time is 4397 us (CPU Frequency:456MHz) 

4096 Point FFT Test End 

-------------------------------------------------- 

11: 8192 Point FFT Test 

-Sampling Period:1s Sampling Frequency:8192Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:10399768 
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-Forward Transformation Execution Time is 22806 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:4193816 

-Inverse Transformation Execution Time is 9196 us (CPU Frequency:456MHz) 

8192 Point FFT Test End 

-------------------------------------------------- 

12: 16384 Point FFT Test 

-Sampling Period:1s Sampling Frequency:16384Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:21118060 

-Forward Transformation Execution Time is 46311 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:8459340 

-Inverse Transformation Execution Time is 18551 us (CPU Frequency:456MHz) 

16384 Point FFT Test End 

-------------------------------------------------- 

13: 32768 Point FFT Test 

-Sampling Period:1s Sampling Frequency:32768Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:45652444 

-Forward Transformation Execution Time is 100115 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:20545012 

-Inverse Transformation Execution Time is 45054 us (CPU Frequency:456MHz) 

32768 Point FFT Test End 

-------------------------------------------------- 

14: 65536 Point FFT Test 

-Sampling Period:1s Sampling Frequency:65536Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:107256472 

-Forward Transformation Execution Time is 235211 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:56478452 

-Inverse Transformation Execution Time is 123856 us (CPU Frequency:456MHz) 

65536 Point FFT Test End 
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-------------------------------------------------- 

15: 131072 Point FFT Test 

-Sampling Period:1s Sampling Frequency:131072Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:218435484 

-Forward Transformation Execution Time is 479025 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:116858320 

-Inverse Transformation Execution Time is 256268 us (CPU Frequency:456MHz) 

131072 Point FFT Test End                           

 

 以上是使能 L1、L2 缓存的测试结果。可以看到测试 128K 点正变换执行时间为 479025 

us ，逆变换执行时间为 256268us。 

7.39 FIR——有限长单位冲激响应滤波器 

 此程序的作用是进行 FIR 有限长单位冲激响应滤波器测试。 

 按照工程导入步骤加载 FIR.out 文件，然后点击程序运行 按钮，程序会在断点处

停下来。 

 点击 CCS 菜单"Tools->Graph->Single Time"，在弹出的界面中按下图数值设置参数。 
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图 153 

 

 点击 OK 即可查看原始时域信号+噪声波形，如下图所示： 
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图 154 

 

 点击 CCS 菜单"Tools->Graph->Single Time"，在弹出的界面中按下图数值设置参数。 
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图 155 

 

 点击 OK 即可查看滤波后时域信号波形，如下图所示： 
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图 156 

 

 点击 CCS 菜单"Tools->Graph->FFT Magnitude"，在弹出的界面中按下图数值设置参

数。 
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图 157 

 

 点击 OK 即可查看原始频域信号+噪声波形，如下图所示： 
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图 158 

 

 点击 CCS 菜单"Tools->Graph->FFT Magnitude"，在弹出的界面中按下图数值设置参

数。 
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图 159 

 

 点击 OK 即可查看滤波后频域信号波形，如下图所示： 
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图 160 

 

Matlab FIR 滤波器辅助设计 

 安装并打开 Matlab R2013a，打开"Filter Designed & Analaysis Tool"工具，在弹出的界

面中按照所需滤波器修改以下参数： 

（1） 滤波器类型：低通 Lowpass； 

（2） 滤波方式： 等纹波 FIR（Equiripple）； 

（3） 滤波器阶数：Specify order（31+1 阶）； 

（4） 采样频率：1000Hz； 

（5） 通带截止频率：150Hz； 

（6） 阻带截止频率：350Hz ； 

 如下图所示： 
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图 161 

 

 点击"Filter Designed & Analaysis Tool"工具菜单"Target->Generate C Header"，在弹出

的窗口中修改"Export as"参数为"Single-precision float"（单精度浮点型），其他设置按下

图所示： 
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图 162 

 

 最后点击 Generate 生成包含滤波器系数的.h 头文件。此头文件的数据用于 FIR 函数，

如下图所示： 

 

 

图 163 

 

备注： 

（1） 信号频率 100Hz，噪声频率 450Hz ； 

（2） 若采用 TI C6000 DSP 库开发，请选用实数 FIR 非优化滤波函数； 

7.40 IIR——无限脉冲响应数字滤波器 

 此程序的作用是进行 IIR 无限脉冲响应数字滤波器测试。 

http://baike.baidu.com/view/1176449.htm
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 按照工程导入步骤加载 IIR.out 文件，然后点击程序运行 按钮，程序会在断点处停

下来。 

点击 CCS 菜单"Tools->Graph->Single Time"，在弹出的界面中点击 Import 按钮，选择

IIR 工程下的"IIR_Graph\IIR_In_Time.graphProp"后点击 OK，可以发现在 CCS 底部出现

如下原始时域信号+噪声波形： 

 

 

图 164 

 

 点击 CCS 菜单"Tools->Graph->Single Time"，在弹出的界面中点击 Import 按钮，选择

IIR 工程下的"IIR_Graph\IIR_Out_Time.graphProp"后点击 OK，可以发现在 CCS 底部出现

如下原始时域信号波形： 
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图 165 

 

 点击 CCS 菜单"Tools->Graph->FFT Magnitude "，在弹出的界面中点击 Import 按钮，

选择 IIR 工程下的"IIR_Graph\IIR_In_FFT.graphProp"后点击 OK，可以发现在 CCS 底部出

现如下滤波后频域信号+噪声波形： 

 

 

图 166 
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 击 CCS 菜单"Tools->Graph->FFT Magnitude "，在弹出的界面中点击 Import 按钮，选

择 IIR 工程下的"IIR_Graph\IIR_OuT_FFT.graphProp"后点击 OK，可以发现在 CCS 底部出

现如下滤波后频域信号波形： 

 

 

图 167 

 

Matlab IIR 滤波器辅助设计 

 安装并打开 Matlab R2013a，打开"Filter Designed & Analaysis Tool"工具，在弹出的界

面中按照所需滤波器修改以下参数： 

（1） 滤波器类型：低通 Lowpass； 

（2） 滤波方式：巴特沃斯 IIR（Butterworth）； 

（3） 滤波器阶数： Specify order（4+1 阶）； 

（4） 采样频率： 1000Hz； 

（5） 通带截止频率：150Hz； 

 如下图所示：  
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图 168 

 

 点击"Filter Designed & Analaysis Tool"工具菜单"Target->Generate C Header"，在弹出

的窗口中修改"Export as"参数为"Single-precision float"（单精度浮点型），其他设置按照

下图所示： 
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图 169 

 

 最后点击 Generate 生成包含滤波器系数的.h 头文件。此头文件的数据用于 IIR 函数，

如下图所示： 

 

 

图 170 

 

备注： 

（1） 信号频率 100Hz，噪声频率 450Hz； 

（2） 若采用 TI C6000 DSP 库开发，请选用实数 IIR 非优化滤波函数； 

7.41 Matrix——矩阵运算 

 此程序的作用是进行 Matrix 矩阵运算测试。 

 按照工程导入步骤加载 Matrix.out 文件，然后点击程序运行 按钮，程序会在断点

处停下来。 
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演示现象 

（1） CCS 的 Console 会打印测试结果。 

[C674X_0] 矩阵运算测试： 

*********************** 

矩阵 A：4*4 

  3.0   0.0   7.0   2.0  

  0.0   0.0  -1.0  -1.0  

  0.0   2.0   0.0   4.0  

  1.0   5.0   0.0   2.0  

矩阵 B：4*2 

  4.0   1.0  

  0.0  -1.0  

  1.0   2.0  

  3.0  -1.0  

矩阵 C：4*4 

  2.0   1.0   0.0  -3.0  

  5.0   0.0  -1.0   9.0  

  4.0   0.0   6.0  -2.0  

  7.0   0.0   1.0   8.0  

*********************** 

矩阵 A 的转置矩阵为： 

  3.0   0.0   0.0   1.0  

  0.0   0.0   2.0   5.0  

  7.0  -1.0   0.0   0.0  

  2.0  -1.0   4.0   2.0  

矩阵 B 的转置矩阵为： 

  4.0   0.0   1.0   3.0  
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  1.0  -1.0   2.0  -1.0  

*********************** 

矩阵 D=A*B：   （外积） 

 25.0  15.0  

 -4.0  -1.0  

 12.0  -6.0  

 10.0  -6.0  

*********************** 

矩阵 E=A.*B：（内积） 

  6.0   0.0   0.0  -6.0  

  0.0   0.0   1.0  -9.0  

  0.0   0.0   0.0  -8.0  

  7.0   0.0   0.0  16.0  

*********************** 

7.42 DCT——图像离散余弦变换 

此程序的作用是进行图像离散余弦变换。离散余弦变换类似于离散傅里叶变换，不过

离散余弦变换只适用于实数，而图像的离散余弦变换是 JPEG 压缩的核心部分 

按照工程导入步骤加载 DCT.out 文件，然后点击程序运行 按钮，程序会在断点处

停下来。 

打开"Tool-->Image Analyzer"，在弹出的 Image 窗口中，右键选择"Import properties"

选项，选择选择位于 DCT 工程目录下 Config 文件夹内的 In.txt 配置文件，等待 20 秒左

右，在 Image 窗口下可查看原始图像，如下图所示： 
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图 171 

 

打开"Tool-->Image Analyzer"，在弹出的 Image 窗口中，右键选择"Import properties"

选项，选择选择位于 DCT 工程 Config 文件夹内的 Out.txt 配置文件，等待 20 秒左右，在

Image 窗口下即可查看经 DCT 变换和 IDCT 变换后的图像，可发现失真很小，如下图所

示： 
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图 172 

 

打开 Img2Lcd.exe 软件，位于光盘 demo\StarterWare\HostApp\Img2Lcd V4.0\目录下，

打开程序后点击“打开”按钮打开任意一张需要处理的 640*480 的 bmp 格式图片，如下

图：  
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图 173 

 

 在左边填写如下图配置信息，点击“保存”。 

 

 

图 174 

 

 在弹出的界面中选择保存的文件名称为"Pic.h"。 

备注：DCT 变换图片长和宽需为 8 的倍数；本次使用图片分辨率为 640*480，颜色为 16

位 RGB565 格式； 

图像转为"Pic.h"文件后，把此文件覆盖 DCT 工程的"Pic.h"文件，重新编译后按本例

程以上步骤操作就可以得到重新设置的图片效果。 

8  更多帮助 

销售邮箱：sales@tronlong.com  

技术邮箱：support@tronlong.com 
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DSP 论坛：www.51dsp.net 

TMS320C6748 学习 QQ 群：162594183、385134684 

OMAPL138 学习 QQ 群：227961486、324023586 

TI 中文论坛：http://www.deyisupport.com/ 

TI 英文论坛：http://e2e.ti.com/ 

TI 官网：www.ti.com 

TI WIKI：http://processors.wiki.ti.com/ 
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图 175 
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